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Introduction

The TechSmith Deployment Tool is designed for Information Technology (IT) specialists or system
administrators responsible for installing Snagit throughout an organization. The tool enables the administrator
to customize and generate a Windows Installer Transform file (MST) and a BAT file.

To view or customize the individual registry settings for Snagit, download the Snagit MSI Installation Guide
from https://www.techsmith.com/enterprise-resources.html

Previous Versions

Download a previous version of the Snagit Deployment Tool Guide:

¢ Snagit 2021 Deployment Tool Guide
¢ Snagit 2020 Deployment Tool Guide

¢ Snagit 2019 Deployment Tool Guide
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Download the Deployment Tool

1. Download the Snagit MSI file and the TechSmith Deployment Tool from www.techsmith.com/enterprise-

resources.html.
Verify that .NET 4.7.2 is installed. Refer to .NET Framework versions and dependencies for details.

3. Double-click the TechSmith_Deployment_Tool.exe to launch the program.

Y,

-

TechSmith_De
ym ent_TﬂﬂIFEg

By default, the Deployment Tool generates the MST and BAT files into the same directory as where

the executable is launched.
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Welcome Screen

A TechSmith Deployment Tool: Welcome = X

" Welcome Welcome to the TechSmith Deployment Tool. This tool will generate 2 Windows Installer®
N\ transform file (MST) so you can customize Snagit, Camtasia or TechSmith Relay Recorder to
suit your deployment needs.

This tool works with:

BSnagit (version 11 or later)
Camtasia (version 8 or later)

m TechSmith Relay Recorder (version 4.2 or later)

Download the latest Windows Installer® (MSI) from this webpage.

Alternatively, you can extract the M5/ from your existing EXE download:

For Snagit 12, Camtasia 9 and later, install the WiX toolset. Then, run on the command-line:
Le. dark %path%Snagit.exe -x Soutputpath.

For TechSmith Relay Recorder, extract the MSI by using a Zip utility.

For Snagit 11 and Camtasio Studio 8, run the EXE on the command-line with the switch /X.
EXE files typically include NET Framework, WebView?2 Runtime, and Visual C+ + redistributable
detection and installation. You must manually update these frameworks for MSI installations and

deployments. Install WebViewZ2 Runtime "per-machine”. See our
Enterprise MSI Installation Guides for more details.

Open M5I Package...

TechSmith Deployment Tool v4.14.0.193

Copyright © 2013 TechSmith Corperation. All rights reserved.

1. On the Welcome screen, click the Open MSI Package button.
2. Select the Snagit.msi file. If you have not previously downloaded the MSI file, download the file here.

3. Click Open.

The MSI file opens in the Deployment Tool and displays the available options for creating a custom MST file.

NOTE: Microsoft .NET Framework, WebView?2 Runtime, and Visual C++ 2019 Redistributed Package
are required to run Snagit 2022. These applications are not automatically installed with the MSI
installer so they must be installed manually before deploying the software.

Install WebView?2 Runtime "per-machine” rather than "per-user” to ensure Snagit's WebView?2 Check
runs correctly. For installation details, see Installing the Runtime as per-machine or per-user from
Microsoft.
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Customize a Snagit Deployment

Click through the tabs on the left side of the TechSmith Deployment tool to view the custom options available.

“& TechSmith Deployment Tool (snagit.msi): General Options — x
N Welcome General Options
£ Begin by registering your software purchase and determining the installation path.
' - Import Settings Registration information
Username:
<« '+ General Options Software Key:

Disable Snagit Settings Installation path

® Use default installation path

Install Features ) Customize installation path:

TechSmith Fuse

Installation options

E
E‘ User Data Paths [] Create shortcuts on Desktop
2,
=

Run Snagit when Windows starts

Add Components
Advanced options

Snagit performs optimizations when it detects it is running in a virtualized environment.
Snagit can auto-detect meost environments or you can select whether Snagit is running on
a virtual machine,

Snagit Registry File

Uninstall Options Virtual Machine Optimization: | Auto-detect ~

TechSmith Relay Cptions Product language
EMNU -

d By e

Install Display Options
i TechSmith support

Allow users to upload Snagit crash logs securely to a TechSmith support agent
'\tl" Create Transform File

The following sections describe the options available on each screen:

¢ General Options

¢ Disable Snagit Settings

¢ Install Features Options
e TechSmith Fuse Options

e User Data Path Options
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Add Components

Snagit Registry File Options
Uninstall Options
TechSmith Relay Options
Install Display Options

Create Transform File
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Import Settings Options

“i TechSmith Deployment Toel (snagit.msi): Import Settings

m Welcome

ﬂ»‘ﬁ-' Import Settings
- General Opticns

Disable Snagit Settings

TechSmith Fuse
" User Data Paths

S

< F—
F
&

Snagit Registry File

w Add Components

% Uninstall Options

m TechSmith Relay Options

Install Display Options

\Tf Create Transform File

Import Settings

Import a Transform File (.mst) to use the previously selected settings.
Mote: Importing the transform file will reset your current Deployment Tool settings.

Open M5T File...

You can duplicate the settings used in a previously created MST file.

1. Onthe Import Settings tab, click the Open MST File button.

2. Browse to select the transform file (.mst).

Importing a transform file will reset your current Deployment Tool settings.

3. Click the Open button.

The Deployment Tool automatically selects the settings from the imported transform file.
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General Options

“i TechSmith Deployment Tool (snagit.msi): General Options — x
N Welcome General Options
A Begin by registering your software purchase and determining the installation path.
; ‘ Import Settings Registration informaticn
- Username:
X 'F‘h‘, General Opticns Software Key:

Disable Snagit Settings Installation path

®) Use default installation path

Install Features ) Customize installation path:

TechSmith Fuse

Installation cpticns

2
E User Data Paths [] Create shortcuts on Desktop
2
=

Run Snagit when Windows starts

Add Components
Advanced options

) _ ) Snagit performs optimizations when it detects it is running in a virtualized environment.
snagit Registry File Snagit can auto-detect most environments or you can select whether Snagit is running on
a virtual machine,

'5“‘ Uninstall Options Virtual Machine Optimization: | Auto-detect ¥
m TechSmith Relay Cptions Product language
EMNU -
g Install Display Opticns

TechSmith support

Allow users to upload Snagit crash logs securely to a TechSmith support agent
AJ2 Create Transform File

Registration Information

Enter a username (e.g. your company or organization name) and the software key. If you have trouble locating
your software key, see License and Software Key FAQ.

If you enter a software key, make sure to select the Disable online Snagit registration dialog option on the
Disable Snagit Settings screen in the TechSmith Deployment Tool.
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At launch, Snagit validates the software key on each computer over an internet connection. For
instructions on how to activate offline, visit our support article:
https://support.techsmith.com/hc/en-us/articles/360050288752-Snagit-2021-Offline-Activation-
Method

Installation Path
By default, Snagit is installed to the following location on a user's machine: %ProgramFiles%\TechSmith\Snagit
2022

To select a custom location, click the Browse button or enter a path to the desired directory.

Installation Options
¢ Create shortcuts on Desktop: Creates shortcuts for Snagit and Snagit Editor on the desktop.

¢ Run Snagit when Windows starts: Starts Snagit and the Capture Window. Snagit Editor starts in the
background.

Advanced Options
Snagit performs optimizations when it detects it is running in a virtualized environment. The performance
optimizations include:

e Crosshairs are simplified when selecting an area to capture.

Optimizations On Optimizations Off

 Shadow effect is removed
¢ Crosshair lines do not extend across the entire screen

* Animation around the selected area is removed
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e The unselected area is not grayed out after a selection is made.

Optimizations On Optimizations Off

¢ When a large desktop is detected:

e Snagit limits visual changes across the entire desktop.
e Snagit limits unnecessary animations.

Snagit can auto-detect most environments or you can select to always apply these optimizations. Select one
of the following options:

¢ Auto-Detect: Apply the optimizations when it detects that Snagit is running on a virtual machine.
¢ Yes: Always apply the optimizations.

¢ No: Do not apply the optimizations.

It is recommended to set this option to Yes when using virtualization technologies.

Product Language
Select the language for Snagit:

e ENU - English

e DEU - German

e ESN - Spanish

e FRA - French

¢ JPN - Japanese

e PTB - Portuguese
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TechSmith Support
Allow users to securely upload diagnostic files to our TechSmith support staff using the TechSmith Support

Toolin Snagit Editor.

The Support Tool is only available in Snagit version 2019.0.1 and later.
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Disable Snagit Settings

“& TechSmith Deployment Tool (Snagit22_1_0_x64_BBId17390.msi): Disable Snagit Settings

N
4

S

=
F
8

g B e

Jr

Welcome

Import Settings

General Opticns

Disable Snagit Settings

Install Features

TechSmith Fuse

User Data Paths

Add Components

Snagit Registry File

Uninstall Cptions

TechSmith Relay Options

Install Display Opticns

Create Transform File

Disable Snagit Settings

Check any of the following features you would like disabled.

[ ] Disable automatic updates

[] Disable online Snagit registration dialog
[ ] Disable Image Capture

[] Disable Videa

[] Disable webcam on by default for video capture
[ ] Disable Printer Capture

[] Disable online help

[] Disable TechSmith account sign-in

[ Disable welcome survey

[] Disable Share Manager

[] Disable local crash dump collection

[] Disable WebView? Check

[ Hide Product Key

[] Disable anonymous usage reporting  Maore Information
() Don't show me notifications
) Only show me help notifications

®) Show me help and TechSmith promaotions

When Should | Consider
Disabling It?

Description

e Asan administrator,
you want to maintain
control of application
updates across the
organization and not

Automatically check for updates for Snagit. If disabled, the user will
not receive any application prompts when new versions are
available.

Automatic
Updates
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When Should | Consider
Disabling It?

Description

allow users to install
updates.

e |f you want to require
individual users or user
groups to be on a
specific version of the
application.

* You do not want the
TechSmith Uploader
Service to install during
an update.

* Prevents the online
registration dialog from
displaying for users.

Online Snagit After installing, the Snagit Registration dialog appears which « Helps to prevent user
Registration includes options to register the software online and sign up for entered errors when
Dialog product announcements, customer stories, and free tutorials. registering the software

or duplicating the
registration information
online.

e |f you want to disable
image capture
including image
capture presets and
options.

Image Image capture takes a snapshot of anything on your screen
Capture including a region, window, scrolling window, or the entire screen.

e |f usersare running
Snagit on a computer
that does not support
video system
requirements.

e Toallow an
Record, trim unwanted sections, and playback MPEG-4 or administrator to control
Animated GIF videos in Snagit. resources
(CPU/GPU/Bandwidth)
when deploying in
virtualized
environments.

Video

e If running Windows
Server 2008 or
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When Should | Consider
Disabling It?

Description

Windows Server 2008
R2 to remove the video
capture and playback
options for users. Video
playback and decoding
is not supported on this
OS.

e |f you only want the

Webcam on The webcam is on by default the first time the user selects video

by default for webcam enabled when
capture mode.

video capture the user selects it.

Snagit installs as a printer destination for programs with printing
capability.

Printers & scanners

Adobe PDF e When deployingin a
server environment
(e.g. Remote Desktop
Fax Services).

Printer
Capture

printer capture,

make sure to also

Microsoft Print to PDF disable the Snagit

Printer option on
the Install Features
tab of the
Deployment Tool.

Microsoft XPS Document Writer

Snagit 2022

Ig:l HP Color Laserlet M255dw (15E858) If you disable

The Printer Capture Option scans the document in a program and
opens the capture in Snagit Editor.

The Snagit help file is located online and requires an internet * If the website is
restricted in your

organization or if users
do not have an internet
connection, you can
choose to disable the

connection. The online help provides content to assist in getting
Online Help started in Snagit and to find answers to product questions. While
offline, users can browse the basic help PDF located in Snagit.
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When Should | Consider
Disabling It?

Description

online help. Disabling
this option opens the
basic help PDF
whenever a user
accesses help in Snagit.

The online help topics are located
here: https://www.techsmith.com/learn/tutorials/snagit.

e Signinis not required
for users when a single
or multi-user key is
entered in the
Deployment Tool.

* Signinginto a
TechSmith account

TechSmith TechSmith Accounts store user-specific information such as
. . . allows users to share to
Account license keys, your user profile, and Screencast.com and TechSmith
Sign-In Relay logins. See About TechSmith Accounts. Screencast.com and
TechSmith Relay.

* You may consider
disabling this option if
you do not want to
require users to have
TechSmith accounts in
your organization.

e |f you select to redirect
the destinations to a

Share The .Sha.re Manager allgws users to update, add, or remove share Sa;h (Ttther than the
Manager destinations from Snagit. To access the Share Manager in Snagit erault.
Editor, select Edit > Editor Preferences > Share tab. o

If you do not want to
allow users to update
the destinations.

Local Crash Allow Snagit to write crash dumps to « When vou need to
C:\Users\username\AppData\Local\TechSmith\Snagit\CrashDum Y

Dump . ps\ for diagnostic purposes. If this is disabled, crash dumps are preserve drive storage
Collection ) . space.
written to a temporary file.
e |f you want to install
your own supported
Disable Prevent Snagit from checking for the installation of WebView?2 and version of WebView?2.
\évk?bvkieWZ from displaying alerts if WebView?2 is not detected. « Or, if you do not want
ec

Snagit to get the latest
version of WebView?2
from Microsoft, which
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When Should | Consider
Disabling It?

Description

WebView? is required:

e Todisplay enhanced tooltips in current versions. requires an internet
connection at the time

e Todisplay account information in future versions. . .
of installation.

If WebView2 Check is enabled, WebView2 Runtime * Or, ifyou do notwant
must be installed “per-machine" to be detected to install WebView?2 at
correctly on end-users' computers. See Installing the all

Runtime as per-machine or per-user from Microsoft.

Prevent Snagit from displaying the key in the Help menu > About

Snagit > Support Information dialog. * If you do not want

Hide Product users to be able to copy

Key
Available in Snagit version 2022.0.1 and later. the key.
Send anonymous data on Snagit usage to help TechSmith improve
future versions. Learn more about TechSmith User Design Initiative * When you must follow
(TUDI). internet security
Disable reqtu.lriments tfhat
anonymous To receive in-app natifications, such as help tips and TechSmith res ;'C S Zsfri rom
, . sending data to
usage promotions, you must enable anonymous usage reporting. TechSmith.
reporting e Or, if you do not want
Snagit sends an initial message during installation for to participate in the
license management and compliance purposes. feedback program.
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Install Features Options

e TechSmith Deployment Tool (Setup_Snagit_x64_Release_EMU.msi): Install Features

n Welcome

‘-— Import Settings
< = General Options
E Disable Snagit Settings
aj Install Features
F TechSmith Fuse
ﬁ User Data Paths
& Add Components
* Snagit Registry File
i Uninstall Options
m TechSmith Relay Options
m Install Display Options

\1". Create Transform File

Install Features

Please select the features you would like to install.

[+/] Snagit Printer
[+] Windows Explorer Menu Extension
4[] Share Destinations
[+] Microsoft Word Destination
[+/] Microsoft Excel Destination
[+] Microsoft PowerPoint Destination
[+/] Screencast Destination
[+] Camntasia Destination
[+] YouTube Destination
[#*] Google Drive Destination
[#] Dropbox Destination
[+] OneDrive for Business Destination
[+] Microsoft OneNote Destination

[+/] Knowmia Destination

[] Force installation of Microsoft share destinations if Office is not installed on the target

system

Snagit share destinations are add-ons to help users upload content to third-party websites and applications.

The destinations appear in the Share dropdown in Snagit Editor.
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Share ?  Share History {3
H File [="] Email
|_Gj| FTP ’_‘ Program
o

Clipboard =2 Printer
E ‘Word - @ PowerPoint -
EE Excel - E OneNote -
u Screencast.com - Camtasia -
u Knowmia ’ Twitter -
Evernote - [ > ] YouTube -
‘ Google Drive - 3 Dropbax -
&l OneDrive For Busi.. v Box -
.-;'- Slack H:) SharePoint -

Select which destinations are available to users. If you disable any of the options above, the destinations will
not appear on the Share tab for the end user.

For example, if YouTube is restricted in your organization, you may want to remove the destination in Snagit.

Option Description

Snagit installs as a printer destination for programs with printing capability.

Printers & scanners
Adobe PDF

Fax

Snagit Printer
Microsoft Print to PDF

Microsoft XPS Document Writer

Snagit 2022

Ig:l HP Color Laserlet M255dw [15E858)

The Snagit Printer option scans the current document in a program and opens
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Option Description

Windows Explorer Menu Extension

Snagit Share Destinations

Microsoft Word Share
Microsoft Excel Share

Microsoft PowerPoint Share

Screencast Share

Camtasia Share

YouTube Share

the capture in Snagit Editor.

Allows users to quickly send and convert images using Batch Export. To
access Batch Export in Snagit Editor, select File > Export.

The destinations appear in the Share dropdown in Snagit Editor and allow
users to share their captures to popular applications.

e gl (O Share

Share 7 ShareHistory {3
— Fil [=7] Eman

@| FTP |_| Program

ol

Clipboard F=2 Printer

E Word - @ PowerPoint -
EE Excel - E: OneNote -
u Screencast.com - Camtasia -
LS Knowmia ’ Twitter -
@ Evernote - [ > YouTube -
‘ Google Drive - g Dropbox -
&fa, OneDrive For Busi.. v Box -
50 siack " SharePoint -
o |

Allows users to insert an image into a Microsoft Word document.

Allows users to insert an image into a Microsoft Excel workbook.

Allows users to insert an image into a Microsoft PowerPoint presentation slide.
Allows users to upload an image or video onto Screencast.com for hosting.
Screencast.com provides a URL for quick sharing or an embed code for
adding the capture onto a website or blog.

Allows users to import an image or video into the TechSmith Camtasia media

bin.

You must have Camasia version 7.0 or later installed to share
captures using this output.

Allows users to upload a video onto YouTube for video hosting. YouTube
provides a URL for quick sharing to your audience or an embed code for
embedding the capture on a website or blog.
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Option Description

Gooale Drive Share Allows users to upload an image or video to Google Drive for image or video
9 hosting. Snagit sends the share link to the Clipboard.

Allows users to upload an image or video to Dropbox for image or video

Dropbox Share hosting. Snagit sends the share link to the Clipboard.

OneNote Share Allows users to insert an image into a Microsoft OneNote notebook.

Allows users to upload an image or video to TechSmith Knowmia. Snagit
sends the share link to the Clipboard.

TechSmith Knowmia Share Deselect this option if you are disabling installation of the

TechSmith Uploader Service under the TechSmith Knowmia
Options tab.

Allows users to upload an image or video to a Slack workspace. Snagit sends

Slack Share the share link to the Clipboard.

Box Share Allows users to upload an image or video to Box for image or video hosting.
Snagit sends the share link to the Clipboard.

Force installation of Microsoft share Forces the installation of Microsoft Office share destinations when Snagit does

destinations if Office is not installed not detect Office installed on the PC. Recommended for customized or cloud

on the target system installations of Office.
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TechSmith Fuse Options

“& TechSmith Deployment Tool (snagit.msi): TechSmith Fuse — x

Mobile Sharing with TechSmith Fuse
Welcome
X\

Mabile Sharing allows Snagit to receive files from TechSmith Fuse. TechSmith Fuse is a mobile
app that allows you to send images and videos from your mobile device directly to Snagit. You

' * Import Settings can capture, collaborate, and access your content - wherever you are,

g _ Enable Techsmith Fuse
General Opticns

A

Port number: | 8299 Configure this number if it conflicts with port numbers
’ used in your organization.

g Disable Snagit Settings
=
:'l:'| Install Features
F TechSmith Fuse
E" User Data Paths
=]
w Add Components
% Snagit Registry File
Uninstall Cpticns

TechSmith Relay Cptions

d By e

Install Display Opticns

'\tl" Create Transform File

TechSmith Fuse is a mobile app that allows you to send images and videos from your mobile device directly to
Snagit. You can capture, collaborate, and access your content - wherever you are.

Fuse is available from the App Store or Google Play and supported on mobile devices running the following
operating systems:

e iOS version 13.6 and later (phones and tablets)

e Android version 7.0 and later
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Some security settings and wireless network environments may not allow connectivity to a desktop.

Make sure to confirm port 8299 is open when working in a virtual environment.
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User Data Paths Options

~= TechSmith Deployment: User Data Paths

N
»

e

r
&
L

PR @

;I._i-“

d k

A

Welcome

Import Settings

General Opticns

Disable Snagit Settings

Install Features

TechSmith Fuse

User Data Paths

Add Components

Snagit Registry File

Uninstall Cptions

TechSmith Relay Options

Install Display Opticns

Create Transform File

Customize User Data Paths

In this page you can customize the location of the user data,

— Automatically stored files

@ |se custom folder:

configuration tips.

= .
i) Use cloud location: | Box

Snagit automatically saves all capture files. Specify a storage location and user permissions.
() Use default location [2eUSERPROFILES\DocumentsiSnagit)

Maote: Library functionality is extremely limited on network storage locations, For full
functionality, specify a local, unmapped folder. See this support article for optimal

-

Allow users to change the automatically stored files location in Editor Preferences.

— Installed share destinations

YouTube, etc.

() Use custom folder:

Select the directory to store installed destinations such as Word, Excel, Google Drive,

® Use default location (3LOCALAPPDATAS TechSmith\Snagit\Outputs\22)

For virtualized environments, you should use a location that is common and
available to all users. For 64-bit environment, we suggest you use:
COMMOMNPROGRAMFILES %6\ TechSmith Shared\Snagit\Cutputs\22

— Other user settings

files, etc.

() Use custom folder:

unigue location for each user,

Select the directory to store user settings such as Quick Styles, Cached Thumbnails, TUDI

@ se default location (ZeLOCALAPPDATAE TechSmith\Snaglt)

Make sure to include environment vanables (e.g. %USERNAMER) to create a

You can change or customize the location for storing user data on the User Data Paths screen.

Automatically Stored Files

Snagit automatically saves all captures in the library folder. Select a location for this folder from the following

options:
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o Default: %USERPROFILE%\Documents\Snagit\

¢ Custom location: Specify a local folder other than Documents.

NOTE: In Snagit 2022.1.0 and later, it is possible but not recommended to set the library
location to a network drive (either directly or indirectly via mapped folder). In this situation:

e File counts are not displayed.
e Searchis limited to file name.
 Filter categories are not available.
e Tagging is disabled.
See Snagit 2022 Network location best practices for optimal configuration tips.

For full functionality specify a local, unmapped folder.
Earlier versions of Snagit 2022 (2022.0.0 - 2022.0.2) do not support network storage at all.

¢ Cloud location: Select a third-party cloud storage option. The third-party app must be installed on the
user's computer. Snagit supports OneDrive for Business, OneDrive Personal, Box, Dropbox Business,
Dropbox Personal, Google Drive, and iCloud.

To help prevent users from losing data and to limit users from changing the path, it is recommended to disable
the options:

¢ Prompt user on first capture to select a storage location.

* Allow user to change the automatically stored files location.
This option for users to change the automatically stored file location is found in Snagit Editor > Edit > Editor
Preferences > Library tab > Library location.

Installed Outputs (Share Destinations)

The Snagit outputs (destinations) appear in the Share dropdown in Snagit Editor and allow users to share their
captures to popular destinations.
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The default location to store the installed outputs (destinations) is:
e For Snagit 2022: %LOCALAPPDATA%\TechSmith\Snagit\Outputs\22

e For Snagit 2021: %LOCALAPPDATA%\TechSmith\Snagit\Outputs\21
e For Snagit 2020: %LOCALAPPDATA%\TechSmith\Snagit\Outputs\20
e For Snagit 2019: %LOCALAPPDATA%\TechSmith\Snagit\Outputs\19
e For Snagit 2013: %LOCALAPPDATA%\TechSmith\Snagit\Accessories

If you select a custom folder to store the installed accessories, consider the following items:

e Forroaming profiles, you should use a location that is common and available to all users. Snagit cannot
load outputs (destinations) from a network drive location.

e |f a user does not have write access to the folder, Snagit disables the ability for users to update or remove
outputs (destinations) from the Share Preferences in Snagit Editor.

Other User Settings

User settings such as quick styles, cached thumbnails, additions to the spelling dictionary, TUDI files, etc. are
stored by default in: %LOCALAPPDATA%\TechSmith\Snagit.
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Add Components

The components added are included in the Snagit installation.

e TechSmith Deployment Tool (snagitmsi): Add Components — bt

N

Welcome

Import Settings

- (General Options

Disable Snagit Settings

Install Features

TechSmith Fuse

User Data Paths

Add Components

Snagit Reqistry File

Uninstall Options

TechSmith Relay Options

Install Display Options

Create Transform File

Add Share Destinations

By default, Snagit includes several common share destinations to programs such as
Microsoft Word and PowerPoint. Download additional share destinations from our website
[here]

2l

WARNING: Some share destinations may have different system requirements than the Snagit
application.

Add Presets

Presets are a set of saved capture settings. Add the exported presets files (.snagpresets)
below.

Add Tool Themes

Themes provide a set of branded Quick Styles for each tool in Snagit. Add the exported
theme files (.snagtheme) below.

Share Destinations

Share destinations are add-ons designed to allow users to upload content to third-party websites and

applications. The destinations appear in the Share dropdown in Snagit Editor.
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The destinations selected on the Install Features screen are included in the installation. To include additional
destinations:

1. Download more destinations to include with deployment from this website:
https://support.techsmith.com/hc/en-us/articles/115002022732.

2. On the Add Components screen, click the Add button.
3. Browse and select the desired .tscplugin file. Control-click to select multiple files.

4. Click Open.

Presets

Set up a preset to automatically remember your capture settings. Use presets to:

e Save commonly used capture settings.
¢ Eliminate the setup time before each capture.
¢ Quickly switch between capture types based on the task at hand.

¢ Reduce the editing required by automatically adding effects or selecting the share location.
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Print Screen
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Add Hotkey
Ctrl+5Shift+B

Add Hotkey

To deploy Snagit with additional presets, add the exported Snagit Preset files (.snagpresets) on the Add

Components screen.

Deployment Tool Guide | 29



1. Export the Snagit Preset file (.snagpresets) in Snagit Editor.

File Edit View Help

L] Praview in Editor
All-in-Cne
Copy to Clipboard
[ o]
Image Capture Cursor
L 5 Second Delay
Wideo

‘ﬂ" Presets 4 -

O Eordered Image to Word

O 200x200 Image with Border

Email Watermark
Web Image to Folder

o]
O Elog Image
O

Panoramic Scrolling Capture

Print Screen

[ Open Editor
Add Hotkey &3
S

Add Hotkey &

Add Hot
Edit...

Ctrl+Shif  Rename

Add Hot Duplicate
Delete

2. Onthe Add Components screen, click the Add button.

3. Browse and select the desired .snagpresets file. Control-click to select multiple files.

4. Click Open.

Tool Themes

Themes provide a set of branded Quick Styles for each tool in Snagit Editor.

Quick Styles

Theme: Department Styles

-“_A;-»
D = QO
S - B - B
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To deploy Snagit with additional themes, add the exported theme files (.snagtheme) on the Add Components

screen.

1. Export the theme file (.snagtheme) in Snagit Editor.

Quick Styles

Theme: Department Styles

Basic

Camtasia colors
Department Styles
Marketing Styles

Snagit colors

» Urban

New Theme...

Import...
A

o

1t
Edit...

Duplicate

Expaort...

2. On the Add Components screen, click the Add button.

Delete

3. Browse and select the desired .snagtheme file. Control-click to select multiple files.

4. Click Open.
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Snagit Regqistry File Options

“i TechSmith Deployment Toel (snagit.msi): Snagit Registry File - ot

m Welcome

‘ Import Settings
o General Opticns

Disable Snagit Settings

TechSmith Fuse
! User Data Paths

S

§:| Install Features
i.'
7

Add Components
Snagit Registry File
Uninstall Cpticns
TechSmith Relay Options
Install Display Options

\Tf Create Transform File

Snagit Registry File

You may include a customized Snagit registry file with the deployment. The most common reasons
for doing so are to distrnbute Snagit with profiles specfic to your environment and epting out of
our TUDI (ancnymous usage data collection). While other options and preferences are contained in
the REG file, Quick Styles and Stamps cannot be customized and deployed with Snagit.

The easiest way to obtain the custornized registry file is to set up Snagit the way you want on
your computer. Then, exit Snagit completely and select the third option below.

®) Do not customize Snagit registry settings
) Customize Snagit registry settings by importing a Snagit.reg file:

File name:

Customize Snagit registry settings by using this computer's settings

Snagit is running. Exit Snagit to select this option.

The registry file contains custom settings within the Snagit application such as presets, appearance settings,

and hotkeys.

Some of these custom settings are located in the following locations:

e Inthe Capture Window, select File > Capture Preferences.

¢ In Snagit Editor, select Edit > Editor Preferences.
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Stamps, Quick Styles, and options in the toolbar are not stored in the registry file and cannot be

deployed to multiple users.

To deploy custom Snagit settings to multiple users:

Install Snagit.

Set up Snagit with the desired settings and customizations for your organization.
Close Snagit.

Run Command Prompt as an administrator.

o A~ W

Make sure Snagit is not running. To create the Snagit registry file on your desktop, enter the following into
the Command Prompt:
"C:\Program Files\TechSmith\Snagit 2022\SnagitCapture.exe" /e %userprofile’%\Desktop\Snagit.reg

6. Inthe TechSmith Deployment tool, click the Snagit Registry File tab and select Customize Snagit registry
settings by importing a Snagit.reg file.

7. Click the Browse button to select a Snagit.reg file produced in step 5.
The transform (MST) file generated from the Deployment Tool will use the settings from the registry as the

default settings when installing Snagit.
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Uninstall Options

“& TechSmith Deployment Tool (snagit.msi): Uninstall Options — x

N o Uninstall Options
elcome
A

Keep or Delete Files
When uninstalling Snagit, users are prompted with the following dialog:

Import Settings

TechSmith Snagit

General Opticns

5‘.1
E'1

@ Keep Preferences

| plan to reanstall Snagit. Remember my preferences
and customizations.

Disable Snagit Settings

Delete Preferences

I do not plan to use Snagit or | will use the default
settings, Delete my Snagit presets, favorites,
tooclbar customizations. quick styles, themes, color
paleties, and share preferences.

When deploying an uninstall, users will be prompted with the above dialeg, unless you

Install Features

TechSmith Fuse

User Data Paths

B+ [

% Add Components choose to keep or delete the user's files below,
®) Prompt users with this dialog

% Snagit Registry File Sl
) Delete files

% Uninstall Options Previous Versions

v

To ensure users are running the correct version of Snagit, you can choose to automatically

) ) uninstall previous versions on their machine,
TechSmith Relay Options . i
% Do not uninstall previous versions

- ; .
) Uninstall all previous versions

d k

Install Display Options .
Al () Uninstall only:

Enter the 2 digit version number (e.g. *18" not *2018"). Separate
\If Create Transform File version numbers by a comma. More Information

Keep or Delete Files

When uninstalling Snagit, there are three options for users’ current Snagit files (unsaved captures, flags, tags,
and capture information). If you plan to reinstall or upgrade Snagit for a user, we recommend selecting the
Keep Files option.

Select one of the following options on the Uninstall Options screen:

¢ Prompt users with this dialog: When uninstalling Snagit, allow the user to select whether to keep or delete
their current Snagit files.
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¢ Keep files: Automatically keep the user’s files when uninstalling Snagit. Users are not prompted with this
dialog.

¢ Delete files: Automatically deletes the user's files when uninstalling Snagit. Users are not prompted with
this dialog.

Uninstall Previous Versions

The UninstallerTool.exe is embedded in the TechSmith Deployment Tool. To download, see Download the

Deployment Tool.

You can uninstall previous versions using:

¢ Uninstaller in the Deployment Tool

¢ Uninstaller Tool Command Line

To uninstall previous versions without deploying a new version of Snagit, see this support article.

Uninstall Previous Versions using the Deployment Tool

1. Download the Snagit MSI file and the TechSmith Deployment Tool from www.techsmith.com/enterprise-
resources.html.

2. Double-click the TechSmith_Deployment_Tool.exe to launch the program.

N7,

-.-I"

TechSmith_De
3

yment_Tool

. On the Welcome screen, click the Open MSI Package button.

3
4. Select the Snagit.msi file. If you have not previously downloaded the MSI file, download the file here.
5. Click Open.

6

. On the Uninstall Options screen, select an uninstall option:

* Uninstall all previous versions

» Uninstall only: Uninstalls specific versions of Snagit. Enter the Snagit major version number.
Separate versions by a comma. Make sure to enter the 2 digit version number (e.g. 20 not 2020).

7. Select the other desired options in the Deployment Tool for installing the new version of Snagit.
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8. On the Create Transform screen, enter the file path and click Create Transform.

9. The toolis extracted to the Batch file location selected. Copy the MSI, MST, BAT and UninstallerTool.exe
files to a folder on the target machine.

You must copy the BAT and UninstallerTool.exe files to the same folder and update the file
paths in the BAT file to match the folder location.

10. Opena command prompt with elevated Admin privileges.

11. Run the batch file to uninstall previous versions of Snagit and then install the new version.

You cannot right-click the BAT file and select Run as administrator to elevate file privileges.

In some instances the target machine must be rebooted to uninstall older versions. A message is
shown if a reboot is required.

Uninstall Previous Version using Command Line

The Uninstaller tool can be run independently or as part of the Deployment Tool process. Make sure to run the
command prompt with elevated Admin privileges.

Flags and parameters:

-product <insert product_name>

-keep <insert comma-separated version list>
-remove <insert comma-separated version list>
-log <log_file_name>

Examples:

1. Remove all versions of Snagit:

UninstallerTool.exe -product snagit

2. Remove only versions 2019 and 2021 of Snagit:

UninstallerTool.exe -product snagit -remove 19, 21
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3. Remove all versions of Snagit except 2019 and 2021:

UninstallerTool.exe -product snagit -keep 19, 21

4. Specify a log file for the uninstaller output:

UninstallerTool.exe -product snagit -log uninstallerLog.txt

By default, the Uninstaller tool writes progress information to the standard output; use the "-log” flag to output
to a named file instead. Windows installer log files are created for each version of Snagit that is uninstalled.
Windows installer log files can be found in the following locations:
¢ MSI installer logs: Located in the same folder as the Uninstaller tool and are in the form of "Uninstall_
<version>_Log.txt"

o EXE installer logs: Located in "%localappdataZ\temp” with a file name in the form of "Snagit_<version>_
Snagitinstaller_<platform>.log"
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TechSmith Relay Options

e TechSmith Deployment Tool (snagitmsi): TechSmith Relay Options — X
Welcome TechSmith Relay Options
N\
l.‘ . Server Information
7 Import Settings

Primary Endpoint is the TechSmith Relay Server URL. Team ID is a GUID which identifies

<. General Options one or more TechSmith Relay servers as a single unit.

[ ] Disable installing the TechSmith Uploader Service

Disable Snagit Settings
Primary Endpoint:

Team ID:

TechSmith Fuse

. [ | Ignore Server Certificate Warnings
- User Data Paths Enabling this feature will allow recorders to connect to servers with untrusted security
certificates like self-signed certificates (not recommended).

ﬁ Install Features
=
i

@ Add Components

ﬁ Snagit Reqistry File

".; Uninstall Options

B TechSmith Relay Options
@ Install Display Options

'\I"' Create Transform File

The Relay Options configures Snagit with a share destination to your specific instance of TechSmith Relay (also
known as Knowmia Enterprise). For this configuration, you need to enter both the primary endpoint (server
URL) and Team ID.

Select the Disable installing the TechSmith Uploader Service option to prevent the TechSmith Uploader Service
from installing during deployment. We also recommend deselecting the TechSmith Relay Destination under
the Install Features tab.
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You must also select Disable automatic updates under the Disable Snagit Settings tab to prevent the

Uploader from installing during an update.

The primary endpoint value is the web address of your TechSmith Relay Server ending in rest.ashx. For

example, http://www.organziation.com/relay/rest.ashx.

The method for retreiving your Team ID depends on your implementation of TechSmith Relay.

¢ |f you have TechSmith Relay (Self-Hosted), you can log in to the TechSmith Relay website as an
administrator and find it on the Servers page.

B Ttechsmih seday X =+

=]
“— (D £ organization.com +r = @A O

x

M TechSmith Relay’

System Presentations Profiles Users Client Downiloads. 9
¥ Zysan T cenen User: Relay Administrator {relayadmin) Sign Oul
TechSmith Ralay Servers Team ID: asabdch(-Ocac-4190-b461-2912a 1508241
Status  Sorcor Hama Version  Last Updated 1. "*““&""“‘"’@
whww organization com 507 SAR0016 6:59.05 PM 0 0 103

Transcnption Job Counl Encoding Job Count

@ WA OrganEation, com

Status: Cnbng

Last Updated: 050016 18:5505
Manager Service Pld; 10076

Encoding License:  Large

Activation Status:  Actesled

Presentations ane being accepted and processed on this i@ Completed 2.7

SErver.
Publish Job Count
.

v Pending 16

& Quewed 0

B Processing 0

) Failad 0

& Completed 11,897

¢ |f you have TechSmith Relay (Hosted), you can locate the Team ID on the Download Recorders page.

1. From your TechSmith Relay homepage, click the Create button and then click the Download
Recorders link.

2. Onthe Download Recorder page, right-click the Configure Snagit button and Copy the link address.

3. Paste the link into a text editor and extract the unique Team ID.

It is not recommended to select the option to ignore server certificate warnings.
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Install Display Options

“i TechSmith Deployment Tool (snagit.msi): Install Display Options - ot

m Welcome

Import Settings
. General Opticns
Disable Snagit Settings
Install Features
TechSmith Fuse
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Snagit Registry File
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% Uninstall Options

TechSmith Relay Options

d

Install Display Options

\Tf Create Transform File

Install Display Options

When the deployment is in progress and Snagit is installing, there are a number of options that will
determine what the end user sees on their screen. If you don't want the user to see anything, select
Quiet display (/quiet). Visit the M5DMN website for addibional details.

Display Options

@) Passive display (/passive)

) Quiet display (/quiet)

Restart Options

® Do not configure the restart options

) Prompt before restarting (/promptrestart)
() Mever restart [fnorestart)

] Always restart (/forcerestart)

Select one of the following options:

e Quiet display: Installs Snagit silently with no setup interface displayed. May be run from a non-
administrator command prompt. It will not return the command prompt until Snagit has finished

installing.

¢ Passive display: Installs Snagit from an administrator command prompt. It returns the command prompt
immediately (non-blocking). The minimal setup is displayed and Snagit notifies the user when the

installation is complete.
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Create Transform File

o TechSmith Deployment Tool (snagit.msi): Create Transform File - ot

’1 Welcome

'&' Import Settings

General Cptions

E Disable Snagit Settings

TechSmith Fuse

_r
T
rl’:‘ Uzer Data Paths

Add Components

% Snagit Registry File

% Uninstall Cpticns

lB TechSmith Relay Options

Install Display Options

- Create Transform File

END-USER LICENSE AGREEMENT FOR
TECHSMITH SOFTWARE — SNAGIT® for
Windows and Mac

IMPORTANT-READ CAREFULLY: This end-user license Agreement
("EULA") is a legally binding license agreement between the entity or
organization you represent, or if you do not designate an entity or an
organization in connection with a license purchase, you in your
individual capacity on behalf of yourself ("you” or "your") and
TechSmith Corporation, whose address is 2405 Woodlake Drive,
Okemos, Michigan 48864 ("TechSmith") for the TechSmith Software
identified above and as further defined in this EULA.

BY PAYING THE LICENSE FEE FOR THE SOFTWARE WITHOUT
PROMPTLY REQUESTING A REFUND OF SUCH FEE OR INSTALLING,
COPYING, OR OTHERWISE USING THE SOFTWARE, SUCH ACTS
INDICATE YOUR ACCEPTANCE OF THIS EULA AND YOUR AGREEMENT
TO BE BOUND BY THE TERMS AND CONDITIONS OF THIS EULA. IF
YOU DO NOT DESIRE TO ACCEPT THIS EULA OR AGREE TO THE TERMS
OF THIS EULA, PROMPTLY RETURN THE UNUSED SOFTWARE TO THE
PLACE FROM WHICH YOU OBTAINED IT FOR A FULL REFUND OF THE
LICENSE FEE.

[ ] I have read and accept the End User License Agreement

Transform file:  |CAUsers\asmithDesktopsnagitmst =y

Batch file: ChlUsers\a.smith\Desktopisnagit.bat T

Create Transform...

1. Select | have read and accept the End User License Agreement checkbox.

2. Click the Create Transform button to generate the following files based on the options selected within

the Deployment Tool:
e Transform file (MST)

e Batch Processing file (BAT)
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Additional Resources

Enterprise Resources

TechSmith Enterprise Resources website
Download other resources and guides to assist with Snagit enterprise installations.

Technical Support

We're here for you! Visit the Technical Support website to submit a ticket, find answers online, or contact an
expert.
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